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Creating Folders in Outlook: By Carole Colburn 
Is your Inbox in Outlook full of old e-mail messages? Do you want to keep them, but 
really do not like to have to scroll through the entire Inbox to find a specific message 
when you need it? The answer for you may be to create folders to keep those special 
messages and help you to be more organized. Here is how you create folders in 
Outlook 2000. 
 

1. Make sure that your Folder List is showing in Outlook. To do this, click the View 
Menu and scroll to Folder List. 

 

 
Created By: Carole L. Colburn  12/13/2001 
  



   

Created By: Carole L. Colburn  12/13/2001 
  

 
2. Once you open the Folder List, this is what you will see. 

 
 
 

 
 

3. The first thing you need to do to create a new folder is select where you want this 
folder to be. Typically, you will want to create new folders in the Inbox. Click on 
Inbox to select it. 
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4. Next, click the File Menu and scroll to New and then to Folder. 
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5. This will open the “Create New Folder” dialog box. It looks like this. You will type 
a name for your folder in the “Name:” field. (Example: Important Parent 
Messages) 
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6. Next, make sure that in the “Folder Contains:” field, it says “Mail Items” and that 

the word Inbox is selected. Then, click the “OK” Button. 
 
 

 
 

7. When you click OK, this dialog box may pop up. This is asking you if you want to 
place a shortcut icon to this folder on your Outlook Bar. If you want this, click 
“Yes”, if not, simply click “No.” You do not have to create a shortcut icon to be 
able to access your new folder.         (Outlook Bar) 
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8. Once you have clicked either “Yes” or “No” the dialog box closes. If you look in 
the Folder List, you will see a plus (+) sign next to the word Inbox. If you click that 
plus sign once, the plus sign changes to a minus (-) sign and the tree expands. 
You should have a folder there named “Important Parent Messages.” 
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9. You can now click on messages from your Inbox, hold the click down and then 
drag the messages into your new folder.  

 
Back to Top of Page 

 
 
FYI: You can create a recurring “Task” to remind you to do things like take attendance. 

1. Click the Tasks Button in the Outlook Bar.  
2. Click the New Tasks Button.  
3. Type a subject for the task. 
4. Put a checkmark in the Reminder Box and set when you would like to be reminded for this task.  
5. Click the Recurrence Button and set when and how often this task will recur.  
6. Be sure to click the Save and Close Button. You will now be reminded to do the given task when it 

needs to be done!  
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Lesson Plan of the Month 

The following lesson plan comes from: http://www.microsoft.com/education/default.asp?ID=Aardvark 

A is for Aardvark 
 

Grade Level: Middle School 
Curriculum Connections: Language Arts, Arts 
Required Software: Microsoft® Word 97/98  
 
What's in this Lesson:  

• Teacher Guide (including How to Begin)  
• Student Activity, Step-by-Step:  

Step A: Make a Letter Template  
Step B: Add a Word  
Step C: Play a Word Game  

 

Teacher Guide 

http://www.microsoft.com/education/default.asp?ID=Aardvark
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Summary: 

To master the art of reading, kids should collect words the way they 
collect baseball cards or Beanie Babies. Few learning tools are as 
powerful as a personal dictionary that a child can create, add to, and use 
as needed. This activity will help you start an electronic dictionary for 
your whole class. 
 

 
With your help, even very young learners can use Microsoft Word 
97/98 to set up a dictionary page template for each letter of the 
alphabet, and then fill in a new page for each word they learn.  

Objectives:  

To build children's vocabulary and spelling skills, reinforce reading 
concepts, and provide fun practice using technology  

Prerequisite Skills:  

Basic introduction to Microsoft Word 97/98, including opening and 
saving files and the ability to use clip art.  

Time Allotted:  

Two class periods to get started; ongoing as needed  

How to Begin:  
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1. To organize your students' work, you'll want to create a set of 
folders on a server or computer accessible to all. Name the main 
folder Our Class Dictionary. Inside this folder, create a folder 
for each letter of the alphabet. In Windows 95/98, if you need 
assistance, select Help, Help Topics, then Index, and search on 
Creating Folders.  

2. Using your class list, tentatively assign a letter to each student, 
but keep A for yourself.  

3. Demonstrate for students how to use Word to create a dictionary 
page template for the letter A, following the model above. 
(Step-by-step instructions are repeated in the Student Activity.) 
Show kids how to use WordArt to make a fancy letter A, upper 
and lower case. Walk through the process of inserting Text 
Boxes and providing template text for words, definitions, and 
your name. Add another text box to provide a placeholder for 
clip art. Then show how to Save As a template called A.dot. 
Close the document.  

4. Demonstrate for students how, when you go to Word, File and 
select New, the A template appears in the General menu. 
Double-click on A, and create a page for an A word. Aardvark 
is sure to get a giggle out of your students, especially if they're 
fans of the Arthur series by Marc Brown.  

5. Show students how to save a dictionary page. When you select 
the File menu and choose Save, Word automatically asks for a 
new file name and indicates that it will save as a Word 
Document, rather than a template. Select your "A" file folder, 
and save the document as Aardvark (or whatever it is).  

6. Print out a copy of your dictionary page. Explain that you will 
add it to your own personal dictionary notebook, but that the 
whole class can now easily look up Aardvark if ever the need 
should arise.  

7. Assign each student his or her letter, and explain that you will 
help each person set up an alphabet letter template.  

 

Student Activity  
 

 

Description:  

Just think of all the new words you learn every day, from the books you 
read and the stories you write. Wouldn't it be great if you could save 
each one and share it with your friends? Now you can. Follow these 
steps to make a special dictionary that you can add new words to all 
year. 
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The WordArt feature of Microsoft Word 97/98 lets you make 
alphabet letters in fun shapes and sizes for your dictionary pages.  
 
 

Step A  
Make a Letter Template  
Software: Microsoft Word 97/98 
What to do: Remember how your teacher made a dictionary template 
page for the letter A? Here's how you can make one for the letter you 
have been assigned. 

1. In Word , go to File and select New. Click on the Template 
button in the bottom right corner. Then double-click Blank 
Document.  

2. Go to Insert, choose Picture, and then click on WordArt. Choose 
a WordArt design you like and click OK. A screen will come up 
that says Your Text Here.  

3. Type in your as-signed letter, once as a capital (big) letter and 
once as a lower case (small) letter. Click OK. Click in the 
middle of your WordArt design, and drag it to the top left hand 
corner of the page. You can also stretch it by clicking and 
dragging on one of the little boxes around the edge of the 
design.  

4. Click outside of your WordArt design and press tab a few times 
to get to the top right corner of the page. Go to “Insert” again, 
and this time choose Text Box. Drag the cross tool to make a 
box just big enough for a kid's name. Click inside it, and type 
the words: Your Name.  

5. Click outside the text box, and press Enter a few times to move 
down the page. Insert another text box. Click in the middle of it, 
then click on a corner and drag it to make it bigger. Click inside 
and type: Enter Your Word Here. Go to Edit, choose Select All, 
and then go to the Format toolbar and make your text bigger and 
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bolder.  
6. Add another text box. Inside this one, type: What does your 

word mean?  
7. Add another text box underneath this one. Inside, type: Put a 

picture here.  
8. When you are happy with your page design, go to File and 

choose “Save.” Name your file for your assigned letter. It will 
automatically save as a template.  

Step B  
Add a Word  
Software: Microsoft Word 97/98 
What to do: Now it's time to make your own dictionary page using one 
of the templates you and your classmates created. Here's how. 

1. Choose a new word you've just learned -- from a book you have 
been reading, from something you saw in your classroom, or 
from a piece of writing you've done.  

 
Use Microsoft Word 97/98 to create a dictionary page 
template for your letter of the alphabet. Use WordArt to 
make a cool letter heading. Then Insert a Text Box for your 
name, the word, its definition, and a picture. Save as a Word 
Template. Then, when you or your classmates open a New 
document in Word, you can choose this page and fill it in 
with a word beginning with that letter!  

2. On the computer, launch Word, go to File, and choose New. 
Open the letter template you need.  

3. Click the first text box once so it is highlighted, and type in your 
name. Repeat this step to fill in the box for your word (be sure 
it's spelled right!) and what it means. For the text box that asks 



   

Created By: Carole L. Colburn  12/13/2001 
  

for a picture, select Insert, Picture, and Clip Art, and choose a 
special illustration that will help you and your classmates 
understand what the word means.  

4. Go to File and choose “Save.”  In “Save In”, choose the Our 
Class Dictionary folder, and open the folder inside for the letter 
your word begins with. Name your document for the word it 
represents and click “Save.”  

5. Print out your page for your personal dictionary.  
6. Keep adding words to the dictionary as you learn them.  

Step C  
Play a Word Game  
Software: Microsoft Word 97/98 
What to do: When everyone has added words to the dictionary, try a 
game like one of these. 

 
Use all your dictionary pages to play word games with your 
friends!  

1. Scavenger Hunt: Challenge your friends to find five new words 
you've added to the dictionary. Make up clues based on what 
each word means, how it's spelled, or what it rhymes with. Open 
a new Word document and type in your clues. Leave a space 
after each one for answers. Print out several copies of the clue 
sheet and see who fills one in first!  

2. Silly Sentences: Team up with three friends. Each player should 
give the others one letter each -- with no repeats. Find one word 
in your class dictionary for each letter your teammates gave 
you. Then make up a sentence using all your words.  

3. Quiz Whiz: Choose a partner. While your partner sits at the 
computer, sit with your back to it. As your partner calls out 
words from the dictionary, try spelling them out loud. Write 
down any you get wrong, then go back to the dictionary and 
study them.  
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***If you have a technology-rich lesson that you would like to share with others, please 
send it to colburnc@howellschools.com no later than the last Monday of the month.  
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 Carole’s Training Corner  
Happy Holidays! Can you believe it is already December? Time sure does fly by! I would like to take this 
opportunity to wish each of you wonderful blessings for this holiday season and all good things for the 
New Year!   

I have completed my rounds to all schools for Laptop help. If you received a laptop from the TTI program 
and need help (but did not get a chance to see me when I was at your school), please let me know via e-
mail and we can work out a one-on-one training. The next set of training rounds at each of the schools 
will be to help people get registered and then start using the ITTI (Information Teacher Technology 
Initiative) that was begun last spring to offer free on-line training for all employees (teachers and staff) 
and students of public education institutions in the state of Michigan. Look for those December training 
dates at http://www.howellschools.com/~training/TrainingCalendarPage.htm 

The next big push, if you will, will be for ABACUS training. ABACUS is the curriculum management 
component to SASI and will allow you to access the HPS District curriculum that is correlated to state 
standards and benchmarks. This training will take place starting in January.  

mailto:colburnc@hps.k12.mi.us
http://www.howellschools.com/~training/TrainingCalendarPage.htm


   
To see the complete list of class offerings for the month, check out the calendar page at 
http://www.howellschools.com/~training/TrainingCalendarPage.htm 
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Tips & Tricks  
The following Tips & Tricks come from: www.wordtipsgold@vitalnews.com/ You can 
have these tips e-mailed to you directly each day by signing up at the above 
mentioned site. 

********************************************************************** 

GETTING CONTEXT-SENSITIVE HELP  
Word includes a complete help system that you can use to answer most 
questions on how the program operates. This system is context-sensitive, 
meaning the help you receive will vary, depending on the context in which the 
help was requested. Word provides a fast way to ask for context-sensitive 
help. To do this, press Shift+F1. When you do this, a question mark appears 
over the mouse cursor. Use the cursor to point to the item for which you need 
help. When you click on the left mouse button, the help system is displayed.  

*******************************
CONTROLLING WIDOWS AND ORPHANS 

*************************************** 

 
In typographical terminology, widows and orphans are closely related 
(no pun intended). These terms refer to one (and sometimes two) lines of a 
paragraph left by itself on a page. A widow is the last line of a paragraph 
left by itself at the top of a page; an orphan is the first line of a 
paragraph left by itself at the bottom of a page. You will want to avoid both 
widows and orphans in your documents, as they break up the flow of the text 
and tend to distract the reader. 
 
Word allows you to automatically control single-line widows and orphans in 
your documents. To control widows and orphans in your documents, follow these 
steps: 
 
   1. Select Paragraph from the Format menu. You will see the 
      Paragraph dialog box. 
   2. Click on the Line and Page Breaks tab. (In Word 6 and Word 95 
      you should click on the Text Flow tab.) 
   3. Make sure the Widow/Orphan Control check box is selected. 
   4. Click on OK. 
  
  
********************************************************************** 
ADDING LINE NUMBERS 
 
There are many types of documents that require the use of line numbers. 
Typically, this is done for legal documents. For instance, each line of a 
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http://www.howellschools.com/~training/TrainingCalendarPage.htm
http://wordtipsgold@vitalnews.com/


   

Created By: Carole L. Colburn  12/13/2001 
  

legal contract may need to be numbered. Word allows you to easily add line 
numbers to your document. This is done in the following manner: 
 
   1. Position the insertion point in the section, which you want to 
      have line numbers. (Line numbering can be controlled on a 
      section-by-section basis.) 
   2. Choose the Page Setup option from the File menu. This displays 
      the Page Setup dialog box. 
   3. Make sure the Layout tab is selected. 
   4. Click on the Line Numbers button. This displays the Line Numbers 
      dialog box. 
   5. Enable line numbers by clicking in the Add Line Numbering check 
      box. 
   6. In the dialog box, specify the number at which you want to begin 
      the numbering and the other characteristics you want used. 
   7. Click on OK, and then click on OK in the Page Setup dialog box. 
 
You should note that you can only see line numbers when working in 
Page Layout view. If you are working in one of the other views, then 
the line numbers are hidden. 
 
********************************************************************** 
PICKING A CONTIGUOUS RANGE OF CELLS 
 
There are many times when you are working with Excel when you need to select 
a range of cells. This is very easy to do using either the keyboard, the 
mouse, or a combination of both. 
 
The first step in selecting a range of cells is to select the first cell in 
the range. With the cell selected you are ready to proceed. 
 
   * Using the keyboard, you can hold down the Shift key as you use 
     the navigation keys (up, down, left, and right arrows) to extend 
     the range. 
   * Using the mouse, you can click on the first cell and hold down 
     the mouse button as you drag the mouse to extend the range. 
   * Using the keyboard and mouse, you can hold down the Shift key as 
     you click on the cell that defines the opposite corner of the 
     range you want selected. 
 
 
********************************************************************** 
ENTERING THE CURRENT TIME 
 
Some people like to use Excel to keep track of the time that they work on 
different jobs. If you want a quick way to enter the current time, simply 
select a cell and press Ctrl+: (that's the colon). Obviously, to access the 
colon you need to hold down the Shift key, so some people might express this 
shortcut as Shift + Ctrl+:. The result is that Excel places the current 
system time in the selected cell. All you need to do is press Enter to accept 
the time. 
 
********************************************************************** 
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Fun Holiday Craft Links For You to Try…     

http://www.dltk-kids.com/crafts/holidays.html 

http://www.kidsdomain.com/holiday/ 

http://www.childfun.com/themes/holidayz.shtml 

http://www.isd.net/stobin/document/cubcraft.html 

http://familycrafts.about.com/library/blspecdays.htm 
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For suggestions or questions regarding TECH TIMES, contact: colburnc@howellschools.com 
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http://www.hps.k12.mi.us/Curriculum1.html
http://glen.cc/mtip/
http://www.remc7.k12.mi.us/oaisd/miclimb/
http://www.cyberlearning.org/
http://www.brainbuzz.com/topsites/Default.asp?CatID=1
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